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Disclaimer and Licensing

Freddie is distributed AS IS. There is no warranty, either express or implied, as to its 
merchantability or fitness for any particular purpose. The author assumes no responsibility for loss 
or damage caused directly or indirectly by this software or its associated documents and/or files.

Freddie is distributed as shareware. It may be distributed freely as long as all files and documents in 
the original distribution archive are kept together. The user is entitled to try the program for 30 days, 

after which time a licensing fee of $15 U.S. ($20 U.S. outside the United States to cover bank 
handling fees) must be paid to the author, or all copies of the software in the user’s possession must 

be destroyed.

The user indicates his acceptance of these terms by using Freddie.

Registration



When registering, please fill out and send in the registration form that comes in the distribution 
archive. This form will help speed processing. The fee for registration is $15 U.S. ($20 U.S. outside 
the United States to cover bank handling fees) (subject to change without notice), which entitles the 

user to a personal license for use. Additional users must register separately. 

Only a check or money order will be accepted. DO NOT SEND CASH THROUGH THE MAIL.

New York residents please add applicable sales tax.

Make check or money order payable to:

Kem Tekinay
c/o Mondore

75-05 64th Place
Glendale, NY  11385

Dedication

Freddie is dedicated to all the long-suffering Mac users who were forced to resort to PC’s to benefit 
from the convenience of offline mail reading. As such, all suggestions, recommendations, bug 

reports, comments, recipes, postcards, real estate deeds, and donations will be accepted and 
appreciated.

Contacting the Author

I can be reached on America Online (KemT), EchoMac, NetMail (1:2603/204), and InterNet 
(kemt@aol.com). I am also a co-sysop on the Not Even Odd BBS (718-997-1189, 14.4 kbps).

For those old-fashioned types, I can be reached at the following address:

c/o Mondore
75-05 64th Place

Glendale, NY  11385

Incompatibilities



My beta-testers and I have tested Freddie with as many different types of software and extensions, 
and under as many different circumstances, as we could manage. Unfortunately, there are always 

incompatibilities that come up unexpectedly.

Fortunately, all the incompatibilities known to me have been resolved. However, if you find an 
incompatibility, or even suspect an incompatibility, please contact me immediately.

For People Who Hate Reading Manuals

Get a QWK packet.

System 6 Users or those without ZipIt™
Decompress it into its own folder. Do not strip linefeeds.

Choose “Open…” from Freddie’s File menu. Select any of the decompressed files to open the 
packet.

Save a bookmark.

System 7 Users with ZipIt™
Drop the QWK packet onto Freddie.

All Users
When you reach the Main window, press the “Mail” button to view your incoming messages.

Use the arrow icons or arrow keys to navigate through messages and conferences. You can select 
the conference you want to view in the Conferences window. You can get a quick look at every 
message in a conference through the Incoming index. Double-clicking or pressing <return> on a 
conference or index entry will take you right there.

Sort the message in the current conference or in every conference using “Sort” in the Options 
menu.

Search for a text string in the to, from, subject, or text fields by choosing “Find” in the Options 
menu. Clicking the “Personal” button will set the Find dialog to find any mail to you.

Mark mail for later retrieval by clicking the “Marked” checkbox in the Incoming or Find Results 
windows. You can mark or unmark a large number of messages by holding down the shift key when 
clicking in the checkbox.

Display all the marked messages by choosing “Find marked” from the Options menu.



Reply to an incoming menu by choosing “Reply” from the Outgoing menu (choose “Reply to 
addressee” to reply to the person being addressed rather than the author). If text of the incoming 
message is selected, it will be quoted automatically. Otherwise, copy text normally and choose 
“Paste quote” from the Edit menu.

Create new outgoing messages by choosing “New” from the Outgoing menu.

Get a brief overview of your found messages and your outgoing messages in their respective 
indexes.

When you are done entering outgoing messages, choose “Create REP…” to save a ZIP file 
containing your outgoing messages. Upload the REP file directly to the BBS. Without a password, 
only the first two outgoing messages will be saved.

You can not change the name of the REP file when saving it, so don’t even try.

Save the text of an incoming or outgoing message to a new text file or append it to an existing text 
file by choosing the appropriate item from the File menu. You can save or append all found 
messages by choosing these items from the Find Results window.

Introduction

For years, hobbyists have been using their computers and modems to connect to remote bulletin 
board systems, the original “party lines.” Eventually, local BBS’s began to connect between 
themselves and form networks, allowing messages that could once only be viewed locally to spread 
throughout the country and the world.

The benefit to the user was obvious. He could now transmit and receive information on a global 
scale, and regularly communicate with people whom he’d never meet otherwise. And all this could 
be accomplished for the cost of a local phone call.

The detriments were far less obvious. As the number of messages being transmitted worldwide grew 
to phenomenal proportions, the users became overwhelmed. With messages in the most popular 
conferences (specialized areas of a network where only one topic or theme is discussed) arriving by 
the hundreds daily, the ordinary user could find that there wasn’t enough time in the day (let alone 
time allowed by the BBS) to keep up with all the areas in which he was interested. And since 
messages were read online, there was no way to effectively screen conferences for messages of 
interest so that the reader could view what he wanted and disregard the rest.

It was out of this fundamental problem in time that the concept of offline mail reading arose. Rather 
than force the user to read the mail in every conference he was interested in while connected over 
the phone, the BBS “packed” all the messages into a file that was then sent to the user via a fast file 
transfer. The user could then hang up the phone and use an “offline mail reader” to read the 



messages contained in the packet.

There are many advantages to reading the mail with a good offline mail reader:

1. The user need not read all the messages in one sitting. He can save the messages at 
any point and return to them at a later time.

2. Messages can be searched for topics of interest to the user. Unwanted messages can be 
quickly bypassed.

3. Text of messages and replies can be easily saved or printed.

4. Replies can be entered at the user’s leisure. There is no rush to quickly enter a 
message for fear of losing the opportunity. Replies can be entered, edited, deleted, or 
saved at the user’s convenience.

5. The phone line remains free while the user reads and replies to mail.

6. Because so little time is taken to download a mail packet (as compared with reading 
messages online), the user can use his extra time for other BBS activities, such as 
downloading files. Or, the user can log off quickly, thus saving time and phone 
charges.

Freddie takes advantage of these benefits and offers much more.

Using Freddie

What You Need

Freddie requires a minimum of 1 megabyte free RAM to run. When opening large packets (over 
700 messages) it is recommended that you increase the application memory size accordingly. A 
good rule of thumb would be 0.5 - 1 k for every message over 700.

Freddie has been tested on an SE with System 6.0.3, and a Plus, SE, SE/30, IIsi, and IIci with 
System 7. Unfortunately, I don’t know if Freddie will run on older systems. Do not attempt to run 
Freddie on any Mac with less than 1 meg of free memory.

Freddie is completely System 7 savvy . This means that it is 32-bit clean, contains balloon help, and 
supports the standard suite of AppleEvents. Freddie also supports custom AppleEvents that let it 
work with ZipIt to handle QWK packet decompression.

Getting a QWK Packet



In order to use Freddie, you must first download a QWK mail packet from a BBS. There are general 
instructions listed below. If you are unfamiliar with this process, you should contact your sysop for 
more information.

QWK “doors” (external programs that create QWK packets) are available on most PC-based 
bulletin board systems and are run directly from the BBS’s main menu. To the user, the program 
will appear like any of the other BBS functions.

The door must be configured the first time it is used. Generally, there is a configure option 
somewhere in the door’s menu. Configuration involves choosing which conferences the user is 
interested in, setting the “last read” pointer (the last message the user has read in that conference), 
and a few other items.

After setting the options, you may request a download. The BBS will then compress the messages 
you requested, along with some supporting files, into a QWK packet (a compressed file with the 
three-letter extension “QWK”). It will then send the packet to you.

Many BBS’s off you a choice of compression formats for the packet. I recommend that you select 
ZIP, a PC standard roughly equivalent to StuffIt for the Mac. These files can be easily decompressed 
on the Mac using utilities such as ZipIt or UnZip. Owners of StuffIt Deluxe can also use that 
application’s built-in unZIP translator.

Where it is available, you should configure the door to automatically update your “last read” 
pointer. Also, the index files (files with the extension “NDX”) need not be included in the packet. 
Freddie has no use for them.

Decompressing the QWK Packet

Once a QWK packet has been downloaded, it must be decompressed. If the BBS door compressed 
the QWK file using ZIP, you may use ZipIt for the Mac to decompress it. You can get ZipIt from all 
the major information services as well as the Internet and Not Even Odd (718–997–1189, 
14.4kbps).

There are two ways to decompress the QWK packet. If you use System 7.x and have ZipIt, you can 
let Freddie take care of it. Simply drop the QWK packet onto Freddie or select “Open…” from the 
File menu and choose the packet there.

NOTE: The first time you do this, Freddie will ask you to locate ZipIt. This information will 
be saved so that Freddie will know where ZipIt is in the future.

The second way to decompress the packet is manually, using a utility like ZipIt or UnZip. I 
recommend that you unZIP the files into a folder with the same name as the BBS. That way, you 
can keep these files together and delete them as a group when you are finished with them.

IMPORTANT NOTE: Do not strip linefeeds when decompressing a packet.



TECHNICAL NOTE: Some information is stored in the MESSAGES.DAT file in the form 
of linefeeds. By stripping them, you will remove crucial information that could cause Freddie 
to crash. Freddie automatically removes linefeeds internally where appropriate.

Opening the Mail

Once the QWK packet has been decompressed, double-click on the Freddie application icon to start 
it.

NOTE: If the QWK packet was decompressed through Freddie, the mail will be opened 
automatically.

WARNING: After decompressing the QWK packet automatically, Freddie will create a 
bookmark with the name of the BBS. If such a bookmark already exists, it will be 
replaced without warning. If you want to hold onto an old bookmark, be sure to rename or 
move it before beginning the decompression process.

Choose “Open…” in Freddie’s File menu. You will be presented with a standard Mac open dialog 
box.

Find the folder containing the decompressed QWK files and double-click on one of them. A status 
bar that says “Reading CONTROL.DAT file…” will appear.

NOTE: Freddie is very comfortable in the multitasking environment of MultiFinder or 
System 7. You may switch to any other application while Freddie performs a time-consuming 
task. However, it is important to remember that Freddie is faster when it is in the foreground 
rather than the background.

NOTE: If Freddie is in the background and needs your attention, it will alert you by beeping 
and flashing its icon on the menu bar. It will merely beep to inform you that it has finished 
some long task such as opening the packet or conducting a search.

After this window disappears, you will be asked to save a bookmark file for that packet. The 
bookmark can be saved anywhere on any volume, as long as that volume remains mounted while 
viewing that packet.

NOTE: Saving a bookmark file at this point is mandatory. Canceling from save dialog box 
will stop the open process, and all windows will be closed.

TECHNICAL NOTE: The bookmark is actually a database used to store all information 
about the packet being opened. The database creates a “keys” file for its own use. Although 
the bookmark may be saved anywhere, it must be in the same folder as the keys file. If you 
are going to move the bookmark, make sure you move the keys along with it.

After the bookmarks has been saved, another status window will appear indicating that the 



“MESSAGES.DAT” file is being read. This file contains the text of the messages received from the 
BBS. After reading it, a message window will appear indicating that the NEWFILES.DAT file is 
being read. This file contains information about new files that the BBS has received since the last 
time you checked.

NOTE: A missing NEWFILES.DAT file will not be fatal to the open process. However, the 
CONTROL.DAT and MESSAGES.DAT files must exist and be in the same folder.

The packet will then be sorted and the Main window will appear.

Depending on your preferences (see the section about Preferences below), you may be presented 
with a box asking if you would like to delete the unnecessary files. These files are the ones that 
Freddie has just transferred to the bookmark file. This option is presented for the user’s convenience 
since the files are no longer required in order to read and reply to the QWK packet.

NOTE: These files include MESSAGES.DAT, CONTROL.DAT, NEWFILES.DAT, 
DOOR.ID, MESSAGE.PTR, SESSION.TXT, the welcome and good-bye screens, and all the 
NDX files. The original QWK packet must always be deleted manually by the user.

Reading the Mail

From the Main window, press the “Mail” button. This will open the Incoming, Incoming index, and 
Conferences windows. See below for a description of each.

All messages contained in the packet can be viewed through the Incoming window.

The Windows

The Main Window

The Main window provides a quick overview of the BBS. From here, you can get information about 
the BBS’s name, location, sysop, the time the packet was downloaded, and more.

It also provides a quick route to the Files, News, and Bulletins windows. Simply push the buttons 
for each and you will be shown the appropriate windows.

NOTE: The News and Bulletins features will be supported when ANSI is added to a future 
version of Freddie.

There is also a “Mail” button in the Main window. By pressing “Mail,” you will be shown the three 
windows you will use the most when reading your messages:  “Conferences,” “Incoming,” and 
“Incoming index.” See the appropriate sections below for a description of each.

NOTE: Your name is also displayed in bold on the Main window. Make sure you copy this 



exactly as it appears onto your registration form. If you use variations of your name for 
different packets, make sure you copy down every variation. The password you receive will 
be based upon how your name appears on the BBS. Spaces, periods, etc. are important. 
Capital versus small letters are treated the same and are not important.

The Incoming Window

The Layout

The Incoming window is where all the downloaded mail can be viewed. The header indicates who 
the message is from, who the message is to, the subject, and when it was written. It also lets you 
know the message and references numbers on the BBS.

Just above the text of the message is a field that lets you know which conference’s messages you are 
currently viewing. You can switch conferences in two ways. See the discussion of the Conferences 
window and the arrow icons below.

Below the message text is a status line. The status of a message can be “PRIVATE” or 
“UNKNOWN,” “READ,” and “REPLIED.”

PRIVATE mail was marked as such by the author, and is intended only for the person to whom it 
was addressed. If you can see a PRIVATE message, it is either addressed to you, or your BBS level 
grants you access to it.

NOTE: When replying to a private message, your reply will also be marked as private. See 
the discussion on marking mail as private in the Outgoing window section below.

UNKNOWN messages are probably private, but the symbol used to indicate this internally is one 
that Freddie does not recognize.

If a message is marked as READ, it means that you have already viewed it at some point through 
Freddie. It is not an indication that the intended recipient of the message has read it.

REPLIED indicates that there are replies to this message in the Outgoing window. You can view 
this reply by selecting “Jump to reply” in the Outgoing menu. See the section about the Outgoing 
menu below.

Navigating Through the Incoming Messages

There are four arrow icons on the bottom right corner of the Incoming window. These are used to 
navigate through all the message viewing windows, and their functions are similar in each one.

First Prev. Next Last



In the Incoming window, the First arrow is used to jump instantly to the first message in the 
conference you are viewing.

The Prev. arrow will display the message that comes directly before the one you are viewing.

NOTE: If you are already looking at the first message in a conference, both the First and 
Prev. arrows will take you to the last message in the previous conference. If there is no 
previous conference, Freddie will beep.

The Next arrow is used to view the message that directly follows the one you are viewing.

The Last arrow will take you to the last message in the current conference.

NOTE: If you are already looking at the last message in a conference, both the Next and 
Last arrows will take you to the first message in the next conference. If there is no next 
conference, Freddie will beep.

NOTE: Message order is determined by the current sort setting. The first time you use 
Freddie, the initial sort is set to Message number. You can change this in the Preferences 
dialog box. See the section about Preferences below.

Navigating With the Arrow Keys

The arrow keys can also be used to navigate through messages in the Incoming and Find Results 
windows only.

The left and right arrows correspond to the Prev. and Next icons and will function exactly as if you 
clicked on one of those icons.

The option-left and option-right arrows correspond to the First and Last icons and will function 
exactly as if you clicked on one of those icons.

The up and down arrows will move the cursor up and down one line.

The option-up and option-down arrows will take you to the previous or next conference.

NOTE: When displaying a new message, the Incoming and Find Results window will appear 
to “flicker.” This is an unfortunate side-effect of changing the text and is due to a minor bug 
in the Prograph environment. This flicker will hopefully be eliminated in future versions.

Marking an Incoming Message for Later Viewing or Saving

By checking the “Marked” checkbox at the bottom of the Incoming window, you can easily find 
that message later on. This is a convenient way to indicate which messages you would like to view, 
save, or reply to later.



You can find all the marked messages by selecting “Find marked” from the Options menu. Freddie 
will search every conference for marked messages and display them in the Find Results window.

You can quickly mark or unmark every message in a conference by holding down the shift key 
when checking the “Marked” checkbox.

Uses for Marked Messages

Marking can be used in a variety of ways. What follows are just a few examples.

The most common use is to keep a simple record of messages you wish to reply to later while 
reading the mail. Mark each message you want to reply to and choose “Find marked” from the 
Options menu after you are done reading. All the messages you want to reply to will be grouped 
into the Find Results window.

Another use is to indicate a group of messages you’d like to save to text later. After choosing “Find 
marked” you can choose to “Save text…” or “Append text…” from the File menu while viewing 
the Find Results window. You will be given the option of saving the text of all the found messages.

You can also use the feature to chain several searches together. Conduct a search and mark all the 
found messages (hold down the shift key while marking a single message). Repeat for as many 
searches as you’d like. Then choose “Find marked” from the Options menu. The results of all your 
searches will be displayed in the Find Results window.

The Conferences Window

You can go directly to any conference by double-clicking on its name in the Conferences window or 
by selecting it with the mouse or the arrow keys and pressing <return>.

The Conferences window displays the number of the conference on the BBS, the conference’s 
name, and the number of messages the conference contains.

NOTE: The list contained in the Conferences window is not a complete list of the 
conferences available on the BBS. It is merely a list of conferences which have messages in 
them within the packet, and it corresponds to the conferences you asked to view when 
configuring the QWK door on the BBS. See the section on Getting a QWK Packet above.

The Outgoing Window

This window is only available when you have actually replied to an incoming message or have 
entered a new outgoing message.



The Layout

The layout of this window is very similar to that of the Incoming window. Refer to that section for 
more details.

This window allows you to edit the To and Subject fields by clicking in them or pressing the Tab 
key and typing. If the cursor is in the Text field, only the Tab key will take you to the next field.

NOTE: When replying to a message these fields are filled in automatically with 
corresponding information from the original message. If it is not a reply, but an original 
outgoing message, the To field is automatically set to ALL, and the subject field is left blank.

Setting the Conference

The conference that the message is to be posted in is automatically set to what Freddie believes is 
the proper choice. However, it too can be modified by clicking on the “Conf…” button that appears 
in the upper right corner of the window. You will be presented with a list of all the conferences 
available on the BBS.

NOTE: This list differs from the one that appears in the Conferences window. Whereas the 
Conferences window lists only those conferences that contain mail, the list available through 
the “Conf…” button shows the name of every conference on the BBS in alphabetical order. 
You can post a message in any conference on the BBS.

NOTE: You can see the list in conference number order by holding down the option key 
while pressing the “Conf…” button.

Quoting from Other Messages

Freddie will allow you to easily quote other messages when entering an outgoing message.

Quotes can have two formats. The Block style looks like this:

On 12/03/91, KEM TEKINAY wrote to BILL WOLK:

>-------------------------------------
Thanks for your help in editing the Freddie manual.
>-------------------------------------

The second format is the Initials style which looks like this:

On 12/03/91, KEM TEKINAY wrote to BILL WOLK:

KT> Thanks for your help in editing
KT> the Freddie manual.

You can choose your default quoting style in the Preferences window (see the section on 



Preferences below) or can toggle temporarily between the two styles by choosing the “Initials 
quoting” item in the Options menu.

Copy a block of text from an incoming or outgoing message using the standard “Copy” item in the 
Edit menu and use “Paste quote” in the Options menu to paste it directly into your outgoing 
message.

NOTE: Trying to paste a quote with text that has been copied from sources other than an 
incoming or outgoing message will yield odd (and sometimes amusing) results.

NOTE: There is an easier way to quote text when replying to an incoming message. Simply 
highlight the text in the message and choose “Reply” from the Outgoing menu. A new reply 
will be created with the selected text inserted as a quote.

NOTE: The Initials style formats the text into logical paragraphs, making it the preferred 
choice for day-to-day quoting. The Block style will copy a quote exactly as it appears in the 
original without formatting it, making it ideal for quoting quotes or text that can’t be properly 
formatted by the initials style.

NOTE: The header can be turned off with the Initials style of quoting. See the section on 
Preferences below.

Marking an Outgoing Message as Private or No Echo

At the bottom of the Outgoing window are two checkboxes, “Private” and “No echo.” The 
“Private” checkbox will restrict a message so that it can be viewed by the receiver only. The “No 
echo” box will indicate that the message is not to be echoed through the networks and is to remain 
on your local BBS.

NOTE: These boxes are provided as a convenience, but are not guaranteed to work on 
every BBS. Although Freddie follows QWK, RIME, and Fido conventions for these 
functions, they are not necessarily supported by the BBS’s software. Both of these functions 
are more likely to work on non-Fido boards. Consult your sysop for more information.

NOTE: Marking a message as “Private,” even when supported by the BBS, does not ensure 
privacy. Your message can be read by every sysop from your own board to the destination 
board. Moreover, malfunctioning software or hardware could make the message accessible to 
everyone. Privacy is generally used to carry on a conversation that is of little interest to the 
rest of the people on the conference. A good rule of thumb is that you should only write 
something in a BBS message that you wouldn’t mind seeing on the front page of The New 
York Times.

The “Tagline”

The tagline is a phrase that appears at the bottom of every outgoing message you create. The tagline 
for every message can be changed by typing it into the box next to the “Tagline” button at the 



bottom of the window.

The standard format for a tagline when the message is posted on the BBS is:

---

* Freddie 1.2.5 * This is a tagline. Ain’t it sweet?

Any text you desire can be typed into this box.

NOTE: Although the length of the text that can be typed into the tagline box is not limited by 
Freddie, you should take care not to exceed 58 characters. Otherwise, the tagline will exceed 
the length of some people’s screens and they will get annoyed with you. Of course, if you 
don’t care about annoying others, simply disregard this note.

The default tagline is “The first full-featured QWK reader for the Mac.” You can change this default 
for a session by typing in a new tagline and pressing the “Tagline” button.

NOTE: You can save a tagline as the default for every session by pressing the “Tagline” 
button after typing in the tagline you want, choosing “Preferences” from the Options menu, 
and pressing the “Save prefs” button. For more information about the preferences, see the 
section on Preferences below.

NOTE: The three dashes that appears above the tagline is known as the “tearline.” This 
tearline can cause problems on some Fido boards. The tearline can be turned off in the 
preferences. Since some boards have the ability to properly format messages that contain a 
tearline, you should consult your sysop about whether you should turn it off or not.

If you are calling a Fido board and don’t know whether the BBS software can handle the 
tearlines or not, turn off the tearline. See the section on Preferences below.

Navigating Through the Outgoing Messages

The arrow icons are used to navigate through the Outgoing messages, and they function almost 
identically to the arrow icons in the Incoming window. See the section about the Incoming window 
above.

The Find Results Window

After doing a “Find…” in the Options menu, the results are displayed in the Find Results window. 
See the section about the Options menu below.

The layout of the Find Results window is identical to that of the Incoming window. See the section 
about the Incoming window above.

You can quickly mark or unmark all the found messages by holding down the shift key when 



clicking on the “Marked” checkbox in the Find Results window.

The Index Windows

You can quickly scan a list of messages or jump directly to any message by opening the Index for 
the window you are viewing. All the display windows (Incoming, Outgoing, and Find Results) have 
their own index. The Incoming window has the Incoming index, the Outgoing window has the 
Outgoing index, and the Find Results window has the Find index.

To jump directly to a message shown in the index, simply double-click on it or highlight it with 
either the mouse or the keyboard and press the <return> key.

The Incoming and Find Indexes

These indexes use the same format to display the messages in their respective windows. The 
message number, who the message is to, who the message is from, and the subject of every message 
is shown. In addition, there is an indication of whether the message is private, has replies, or has 
been previously viewed by you from within Freddie.

The index shown in the Incoming index is created the first time you enter a conference. Once 
created, Freddie “remembers” the index for the current sort, and it is updated on-the-fly.

The Incoming index also shows that name of the current conference at the bottom of the window.

The index shown in the Find index is created during the search and it is also updated on the fly. 
However, the Find index may not be updated absolutely. For example, reading a message in the 
Find Results window will mark it as “READ” in the Incoming and Find indexes, but reading it in 
the Incoming window will not mark it as having been read in the Find index. The message will be 
properly updated when it is actually viewed through the Find Results window. This is to provide a 
means of taking a static “snapshot” of certain messages for those that might need such a function.

The Outgoing Index

The Outgoing index provides information similar to that found in the other two indexes. You are 
shown to whom the message was written, its subject, the message number of the incoming message 
to which you are replying (NONE if it is a new outgoing message), and whether the message is 
private.

NOTE: The Outgoing index is updated periodically. Therefore, changes made to an outgoing 
message might not be reflected in the index immediately.

The Files Windows



The Files window displays the new files available on the BBS since the last time you logged on.

The Menus

File Menu

Open…

Opens a QWK packet or bookmark.

You will get a standard Open dialog box. Find the folder that contains the QWK packet (if you use 
System 7 and ZipIt), all the files of your decompressed QWK packet, or the bookmark and open any 
file.

NOTE: The decompressed files must be kept together in the same folder. Otherwise, Freddie 
will report an error while opening the packet.

If you open the files of a decompressed QWK packet, you will be asked to save a bookmark after 
the CONTROL.DAT file has been opened. You must do this here or the open process will be 
aborted.

Close

Close a currently open packet.

Save bookmark

Saves the packet information, your replies, your positions, and window positions into a bookmark 
file.

Saving a bookmark creates two files, one for the bookmark and one for the “keys.” The keys file is 
required by the bookmark and the two should be kept together. If you rename the bookmark, be sure 
to rename the keys file with the same name with the word “keys” at the end. For example, if you 
rename “BBS bookmark” to “George,” the keys file must be renamed from “BBS bookmark keys” 
to “George keys.”

NOTE: After opening a bookmark, only the Main window will be opened. You can then open 
any window you wish to view, and it will be in the same position as when you saved the 
bookmark.

NOTE: Outgoing messages are saved to disk only when you save a bookmark. Otherwise, 



they are kept in RAM and could be lost in the event of a crash or power failure. It is 
recommended that you save a bookmark after entering every Outgoing message.

TECHNICAL NOTE: Saving a bookmark first is the only way to edit replies after closing a 
packet. Freddie can not read the REP files directly.

Depending on your preferences, the bookmark may be periodically compacted when saving. 
Compacting removes empty spaces from within the bookmark that are caused by formatting 
messages and saving replies. This reduces the bookmark’s file size. See the section on Preferences 
below.

Compact bookmark

Force the instant compacting of the bookmark.

Compacting removes empty spaces from within the bookmark that are caused by formatting 
messages and saving replies. This reduces the bookmark’s file size. Choose this if the bookmark 
grows too large in size.

Save text…

Save an incoming or outgoing message to a text file.

If you choose this item while in the Find Results window, you will be given the option of saving all 
your found messages to a text file.

Append text…

Append the incoming or outgoing message to an existing text file.

If you choose this item while in the Find Results window, you will be given the option of appending 
all your found messages to the end of a text file.

Create REP…

Save all your outgoing messages to a REP file that can be uploaded directly to the BBS.

The REP file is saved in ZIP format which can be read directly by the BBS. Once saved, send the 
REP file to the BBS by opening its QWK door (the same way you did when you downloaded the 
QWK packet) and choosing “upload” from the door’s menu. The outgoing messages will be posted 
in their appropriate conferences.

NOTE: Until you register your copy, Freddie will only save the first two outgoing messages 
in the REP file. Once you have registered, you will receive a password that will allow you to 



save an unlimited number of outgoing messages.

IMPORTANT NOTE: Although you get a standard save box when saving the REP file, 
Freddie will not allow you to rename the REP file when saving it, even if you enter a 
different name. This is because the REP file must be named “<BBS name>.REP” when 
uploaded to the BBS. Freddie will not allow you to mistakenly name it something else. The 
drawback is that you could replace an existing REP file for that BBS without warning and 
without meaning to do so.

Print…

A standard print dialog box that allows you to print an incoming or outgoing message.

Edit Menu

Undo

Not implemented in this version.

Cut, Copy, Paste, Clear, Select all

These items perform their standard functions.

Paste quote

Paste text that has been copied from an incoming or an outgoing message into an outgoing message 
as a quote.

Quotes can have two formats. The Block style looks like this:

On 12/03/91, KEM TEKINAY wrote to BILL WOLK:

>-------------------------------------
Thanks for your help in editing the Freddie manual.
>-------------------------------------

The second format is the Initials style which looks like this:

On 12/03/91, KEM TEKINAY wrote to BILL WOLK:

KT> Thanks for your help in editing
KT> the Freddie manual.

You can choose your default quoting style in the Preferences window (see the section on 
Preferences below) or can toggle temporarily between the two styles by choosing the “Initials 



quoting” item in the Options menu.

Before you can paste a quote you must copy a block of text from an incoming or outgoing message 
using the standard “Copy” item in the Edit menu.

NOTE: Trying to paste a quote with text that has been copied from sources other than an 
incoming or outgoing message will yield odd (and sometimes amusing) results.

NOTE: There is an easier way to quote text when replying to an incoming message. Simply 
highlight the text in the message and choose “Reply” from the Outgoing menu. A new reply 
will be created with the selected text inserted as a quote.

NOTE: The Initials style formats the text into logical paragraphs, making it the preferred 
choice for day-to-day quoting. The Block style will copy a quote exactly as it appears in the 
original without formatting it, making it ideal for quoting quotes or text that can’t be properly 
formatted by the initials style.

NOTE: The header can be turned off with the Initials style of quoting. See the section on 
Preferences below.

Outgoing Menu

New

Create a new outgoing message.

Reply

Reply to the incoming message you are viewing.

By replying to an incoming message, you create a “link” between that message and its reply. You 
can easily move between linked messages by using the “Jump to” menu command (see the next 
section).

There is no limit to the number of replies that can be created to the same incoming message.

Reply to addressee

Reply to the incoming message you are viewing, but address the reply to the person in the “To” 
field rather than the “From” field.

By replying to an incoming message, you create a “link” between that message and its reply. You 
can easily move between linked messages by using the “Jump to” menu command (see the next 
section).



There is no limit to the number of replies that can be created to the same incoming message.

Jump to reply/Jump to original message

Go to the message linked to the one you are viewing.

Links are created when you reply to an incoming message. There is no limit to the number of links 
that can be created, nor the number of replies to which an incoming message can be linked.

NOTE: You can “Jump to reply” from the Find Results window. However, choosing “Jump 
to original message” will always take you to the Incoming window.

Delete outgoing…

Permanently delete the outgoing message you are viewing.

NOTE: If you had saved a bookmark after entering the message, but had not saved one after 
deleting it, you can recover the message by closing the packet without saving a bookmark, 
and then opening the old bookmark.

Options Menu

Find

Search the incoming messages for a string of characters. Searches are not case sensitive.

You can search for messages that are addressed to you by pressing the “Personal” button that 
appears in the Find dialog. The settings will be correctly adjusted to find mail addressed to you. You 
can then modify the settings further, or press “Find” to begin the search.

Messages that are found will be displayed in the Find Results window.

NOTE: The string you are searching for must be typed exactly as it appears in
the message, or it will not be found unless you check the “Ignore CR’s” box. If you search 
for two or more words that are consecutive but appear on different lines in the message, that 
message will not be found.

For example, if you were searching for the words “in the message,” an incoming message 
containing the paragraph above would not be found since “in” appears on a different line 
from “the message.”

By checking the “Ignore CR’s” box, true paragraphs are formed while Freddie searches the 
text, allowing a string like “in the message” to be found. This can make the search last 2 - 4 
times longer, so use this option with care. This option is only available when the “Text” box 



is checked, and the default is always off.

TECHNICAL NOTE: Due to the way messages are stored in the QWK packet, they are 
displayed with a carriage return at the end of every line. Thus, although two words on 
different lines appear to be consecutive, they have a carriage return between them, and will 
not match the pattern entered in the “Find what” box unless the user chooses to strip the 
carriage returns by checking “Ignore CR’s”.

Find marked

Search for every message you have marked by checking the “Marked” box and display them in the 
Find Results window.

This option is not available if there are no marked messages. See the discussion about marking 
messages in the section on the Incoming window above.

NOTE: Choosing Find marked will lose the results of your previous search. If you wish to 
retain those results, mark all the found messages by holding down the shift key while 
clicking in a “Marked” box, and then choose “Find marked.”

Sort

Sort the current conference or every conference by the person to whom the message is addressed, 
the person who wrote the message, the subject, or the message number.

The default sort when a packet is opened can be set in the Preferences dialog box. See the 
discussion about Preferences below.

NOTE: Although Freddie does not allow true sorts by thread, sorting by subject will usually 
accomplish the same thing.

Initials quoting

Toggle the Initials quoting style on or off temporarily. See the section on Quoting above.

NOTE: Choosing the quoting style in this manner will only be effective until you quit 
Freddie. To make a particular quoting style the default, choose that option in the Preferences 
window. See the section on Preferences below.

Password

Enter or remove a password or passwords.

Passwords are obtained by registering your copy of Freddie. See the section on Registration above.



NOTE” Without a password, only the first two replies will be saved in the REP file. Both 
replies will contain a tagline that reads “This copy of Freddie 1.2.5 is being evaluated” 
instead of any tagline you have entered for that reply. You can lift both of these restrictions 
by registering your copy of Freddie.

Passwords need only be entered once unless the “Freddie prefs” file becomes corrupted or is 
removed from the same folder as Freddie.

NOTE: Modifying the passwords will also save your current preferences, window positions, 
and default tagline. In other words, it has the same effect as pressing the “Save prefs” button 
in the Preferences window.

Preferences

Set your preferences. See the section about Preferences below.

Windows Menu

Open the window (if necessary), and bring it to the front.

Center all

Center every window on your main monitor whether they are open or not.

Choose this to quickly arrange your windows. This is especially useful if you open a bookmark that 
was created and used on a Mac with a larger monitor, or more than one monitor.

NOTE: If you choose a window from the Windows menu and it does not appear, choose 
“Center all” to see it.

Close and Close all

Provide a way to close windows from the menus.

NOTE: The Main window is never closed while there is a packet open. Therefore, “Close 
all” should be thought of as “Close all except Main.”

Preferences



Freddie allows you to customize certain aspects of its operation through the Preferences window, 
available in the Options menu.

Background formatting

Due to the nature in which messages are stored in the QWK packet, they must be formatted before 
they can be displayed in a Macintosh window. This formatting occurs just before the message is 
displayed. Using this option, you can also set it to occur in the background while you are reading 
messages. The default is turned on.

If you find that Freddie has become sluggish or unresponsiveness to mouse clicks, turn background 
formatting off. If Freddie is taking too long to format and display new incoming messages, turn it 
back on.

If background formatting is on, Freddie automatically turns it off after it has finished formatting all 
the incoming messages. It is not turned on again until you open a new packet or bookmark, or until 
you save your preferences again through the Preferences dialog.

Once a message is formatted, either in the background or foreground, it is saved directly into the 
bookmark file so that it need never be formatted again.

This feature can also be modified somewhat by setting the “Show status bar if message is longer 
than” option. See the next section.

Show status bar if message is longer than:

The number you enter in this box determines how long a message must be before you see a status 
bar during formatting. The default is 2000 characters.

Long messages can take several seconds to format on some machines. Without a status bar, it may 
appear as if the Mac has locked up. This option allows you to determine when you will see the 
status bar during formatting. Messages shorter than the limit in this box will simply be formatted 
without showing you a status bar.

Messages longer than this limit will never be formatted in the background. Thus, you can speed up 
background formatting by setting this to a lower number so that only short messages will be 
formatted in the background. Or, you can increase this number to ensure that all messages are 
formatted in the background.

Users of faster Macs might want to increase this number since the status bar slows the formatting 
process somewhat and longer messages can be formatted in the background with less disruption to 
the user.



On startup:

By changing these settings, you can change the way Freddie shows you a packet when it is first 
opened.

Sort by:

Use this pop-up menu to determine the initial sort. The default is set to “Message number,” but  it 
can be changed to “To,” “From,” or “Subject” as well.

Sorting by Subject generally has the same effect as threading and is the recommended initial sort.

Delete files:

Since all the information Freddie requires from the files in a QWK packet is saved in the bookmark 
file, the original files are no longer needed. Freddie can delete these files for you after the bookmark 
has been successfully saved.

The files Freddie will delete are “CONTROL.DAT,” “MESSAGES.DAT,” “NEWFILES.DAT,” 
“DOOR.ID,” “MESSAGE.PTR,” “SESSION.TXT,” the welcome and good-bye screens, and all the 
index files (files ending with the “.NDX” extension).

NOTE: The QWK packet itself and some files extracted from it are never deleted by Freddie 
and must be deleted manually by the user.

The default setting is for Freddie to ask whether you would like these files deleted.

Find personal

When checked, Freddie will automatically do a search for all messages addressed to you and 
display any it finds in the Find Results window. The default setting is unchecked.

Show Mail

When checked, Freddie will automatically show the Conferences, Incoming, and Incoming index 
windows. These are the same windows that appear when you press the “Mail” button in the Main 
window. The default setting is unchecked.

Create indexes

When checked, Freddie will create an index for every conference for the current sort after reading 



the QWK packet. The default setting is unchecked.

Checking this will avoid delays later on as you enter a new conference, but it will make the startup 
process take longer.

Beep on:

You can customize most of Freddie’s warning beeps.

Personal

When checked, Freddie will beep when it displays a message to you in either the Incoming or Find 
Results windows. The default is unchecked.

Finished background format

When checked, Freddie will beep twice when it completes background formatting. This is useful in 
gauging whether background formatting should be left on or in determining the best number to enter 
into the “Show status bar if message is longer than” box. The default is checked.

Change conference

When checked, Freddie will beep once when you move to another conference by using one of the 
arrow icons in the Incoming window. Freddie will also beep twice when you try to go past either the 
beginning or end of the packet.

When unchecked, you will receive no notice that you have moved into another conference with an 
arrow icon. Also, Freddie will only beep once when you reach the end of the packet.

The default setting is checked.

Quotes:

Block

Make the block style of quoting the default. See the section on Quoting above.

Initials

Make the initials style of quoting the default. See the section on Quoting above.



Header

Insert a header above the quote when using the initials style.

The header has the following format:

On 01-04-92, BILL WOLK wrote to KEM TEKINAY:

This header is not optional for the block style.

NOTE: Headers are “intelligent.” If one is detected in the outgoing message you are quoting 
into, it will not be inserted again.

Auto-compact:

Choose if and when the bookmark will be compacted when saving. The default setting is 15%.

You can choose “Always,” “5%,” “15%,” “25%,” “50%,” or “Never” from the pop-up menu. The 
percentages refer to what percentage of the information contained in the bookmark is empty and can 
be removed. The lower the percentage set, the more frequently the bookmark is compacted when 
saved.

If you have a lot of disk space, you can set this option to a higher percentage or “Never.” If your 
disk space is limited, you should set this to a lower percentage or “Always.”

NOTE: The bookmark is always compacted when you close a packet, regardless of the 
setting here.

Tearline:

Toggle the tearline in outgoing messages. The default setting is on.

The “tearline” is the three dashes (“---”) that appears in the line before the tagline. It can cause 
problems for some Fido-based boards. If you are calling a Fido board, you should consult your 
sysop as to its proper setting. If in doubt, turn it off.

Saving Your Preferences

By pressing the “Save prefs” button in the Preferences dialog, you will save the settings in a file 
called Freddie prefs which is kept in the same folder as Freddie. You will also save the current 



window positions for all opened and unopened windows. Thus when you restart Freddie, the 
windows will be positioned in the same way they were positioned when you saved your 
preferences.

NOTE: Window positions are also saved in bookmarks, and those positions will supersede 
the ones set in your preferences until Freddie is restarted.

Some QWK Tips

Conference Manipulation

Generally, you choose which conference to read while online in the BBS’s QWK door. However, 
you can usually send messages to the QWK door while offline allowing you to configure it.

Three commands seem to be universally supported: ADD, DROP, and RESET. To use them , create  
new message in the conference you want to manipulate and address it to the QWK door or to 
QMAIL (generally supported). The subject should be one of those commands.

For example, let’s say you wanted to start receiving messages in the “Exciting” conference, and 
wanted to stop receiving messages in the “Boring” conference. The BBS’s QWK door is MkQWK.

First, create a new outgoing message and place it in the “Exciting” conference by clicking on the 
“Conf…” button. Put “MKQWK” (the name of the QWK door) or “QMAIL” into the “To” field. 
Make the subject “ADD”.

Next, create a new message and place it into the “Boring” conference. Address it to “MKQWK” or 
“QMAIL” and make the subject “DROP”.

NOTE: “QMAIL” can often be used in the “To” field since it was the original QWK door. If 
you are in doubt as to what you put here, consult your sysop.

When you send the REP packet containing these messages to the BBS, the QWK door will add 
“Exciting” to, and remove “Boring” from, the list of conferences you want to receive in your next 
QWK packet.

The format for resetting a conference to a particular message number is generally the same as 
above. The subject should be “RESET n” with “n” being the message number to which the 
conference should be reset.

Routing Messages in PCRelay

You can route messages directly if the message is going through PCRelay. The best indication of 



this is if a message from the person you want to route to has the words “PCRelay:” at the bottom.

The format for routing is to put the characters “->“ at the top of your message, followed by the 
name of the board where the person can be reached (you can determine this by looking at the 
characters directly following the words “PCRelay:” in their message). The next line should be 
blank.

For example, if you wanted to route a message to me, you would take a look at one of the messages 
I have written and find that “PCRelay:MOONDOG ->“ appears at the bottom. To route a message 
to me, your message would look something like this:

->MOONDOG

Hi Kem! Just wanted to drop you a note telling you how much I like Freddie.

If an incoming message is routed or private, Freddie will automatically put in the appropriate text to 
route it back to the sender when you reply.

Tips for Speedier Operation

Users of 68000 machines especially may notice that Freddie is not the fastest application in the 
world. This is due to the combination of being written in Prograph and the amount that Freddie has 
to do in order to bring QWK to the Mac environment, and provide all the additional features that 
Freddie provides. While I continue to achieve better performance for future versions, there are 
things that you as the user can do now to get faster operation:

•Keep the index windows closed.

Updating indexes takes a lot of processor time. Updating and then displaying them takes even more. 
Keep the index windows closed when you are just browsing through messages from beginning to 
end.

•Do as much at startup as possible.

Generally, the more you have Freddie do on startup, the better. Set it to Find Personal and Create 
indexes on startup. You can then leave or switch to another application and have Freddie finish the 
bulk of it’s work while you are away.

•Use background formatting wisely.

There are two schools of thought on background formatting. One says that you should turn it off to 
get a quicker response while browsing messages. The other says that, if you deal with the initial 
delay while browsing, you will gain it back later when the background formatting is finished. 
Freddie will respond quickly and display new messages faster as well. Plus, if you walk away, 
Freddie can use that time constructively.



•Set the “Show status bar if message is longer than:” limit higher.

Showing a progress bar takes processor time. Generally, actions can be sped up significantly if 
Freddie doesn’t have to show the progress bar as well as perform the action. By setting the limit 
higher, Freddie can use the time it would have otherwise used on the status bar to format messages.

Just remember that, if you set the limit too high, Freddie will appear as if it has frozen when in fact 
it is simply formatting a very long message.

Version History

1.0

Initial release version.

1.1

Bug Fixes

•If the number of characters in the text was a multiple of 128, Freddie would loop endlessly while 
creating the REP file.

•Typing a line with no spaces that wrapped to the next line in an outgoing message would cause a 
crash while creating the REP file.

•The “Find marked” menu item was not always updated correctly.

•Replying to a message without selecting anything would clear the clipboard.

•Selecting “Find personal” on startup would conduct a search even if there were no personal 
messages.

•The bookmark could become corrupted under certain circumstances while viewing Incoming 
messages in the Find Results window. This corruption resulted in lost messages.

•A corrupted packet could cause Freddie to crash while opening it. Freddie will now warn the user 
that a packet may be corrupted, and should handle corrupted packets better.

•Some routines were overly RAM-intensive, causing out-of-memory errors in otherwise plentiful 
RAM environments.

•Miscellaneous minor bugs.



What’s New

•Initials quoting with an optional heading.

•If the heading already exists in the message you are pasting a quote into, it is not pasted again.

•Arrow keys will navigate through the Incoming and Find Results windows.

•Mail you wrote is automatically marked as “Read.”

•”RE:” in most of its forms is stripped from the Subject of an incoming message.

•If you create a new message in a conference whose name contains “PVT,” “PRIVATE,” or 
“NETMAIL,” the “Private” box is automatically checked. The same is true if you change the 
conference of the outgoing message to one of those conferences.

•The user can now have Freddie auto-compact a bookmark in when saving. There is also a 
“Compact bookmark” menu option.

•Standard format for tearline and tagline. The tearline can be turned off for Fido-based boards.

•Searching for strings that wrap to two or more lines by checking the “Ignore CR’s” box in the 
Find window.

•Double-clicking on bookmark while Freddie is running opens that bookmark.

•Messages sent via PCRelay that are private or routed will be automatically routed back when you 
reply.

•Holding down the option key on startup skips the About… box.

•Holding down the option key when pressing the “Conf…” button in the Outgoing window presents 
the list of conferences in the order conference number.

•A “Reply to addressee” menu option.

•A “Center all” menu option to center all the windows.

•The user can choose to have an index created for every conference on startup.

1.1A

Bug Fixes

•Freddie would crash in certain low-memory situations involving the use of indexes.



1.2

Bug Fixes

•The CRC code was occasionally calculated incorrectly when creating the REP packet.

•Dates were not included in the REP file causing them to be incompatible with some QWK doors.

•If the user tried to save the bookmark to a different volume than the one the QWK files were 
located, Freddie would crash.

•When selecting from an index, the index would jump to the beginning and back to the entry.

•NDX files for conferences with more than 3 digits were not deleted automatically.

•Previous versions were not 32-bit clean.

•Assorted bugs that were fixed by two updated to the Prograph environment.

•Assorted minor bugs that I can’t remember fixing.

What’s New

•Full multitasking in every area.

•Notification of the user when Freddie needs attention when in the background.

•Control characters are restricted unless the user holds down the shift key.

•Messages are now displayed using the PC extended character set (with thanks to Ray Arachelian).

•More variations of “Re:” are stripped from the Subject when opening a packet.

•Faster formatting of messages resulting in faster background formatting, quoting, and creation of 
REP files.

•Ability to press <return> to jump to a message or conference from one of the indexes or the 
Conference window.

•Creating a new outgoing message now highlights the “To” field rather than leaving the cursor in 
the “Text” field.

•All windows are now resizable vertically.

•Prompts to save an unsaved REP before closing a packet or quitting.



•Increased speed in opening a packet.

•Better compatibility with some non-standard QWK doors.

1.2.5

Bug Fixes

•Extra files in QWK packet weren’t being properly deleted.

•Bug in Prograph code would cause occasional bookmark corruption.

What’s New

•Full support for System 7 AppleEvents.

•Internal support for special AppleEvents that let Freddie use ZipIt to handle QWK packet 
decompression. Special thanks to Tommy Brown, author of ZipIt, for talking me through these 
routines.

•Consolidated “Open” menu items.

•Now starts up in an Open file dialog rather than the About box.

•Direct support for MkQWK (subject line is transferred when replying to NetMail).

What’s Coming Up

Freddie is an ongoing process, and I already have several ideas as to what to include in future 
versions. Here is a partial list of what you can expect:

• Incorporation of ANSI

• The use of a PC-like TrueType font that allows for the extended character set

• Support for to, subject, tagline, and twit lists

• More color

and much more.



Feel free to contact me with your suggestions or criticisms. Some of the best ideas for Freddie came 
from my beta-testers, so if you’d like to see something added, speak up!

You just might find your name in the acknowledgments!

Kem Tekinay
c/o Mondore
75-05 64th Place
Glendale, NY  11385

AOL: KemT
NetMail: 1:2603/204
InterNet: kemt@aol.com


